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Take charge of Windows XP with these 10+ power tips

Disable Windows XP’s Error Reporting notification
Note: This tip is for both Windows XP Home and Professional.

When Windows XP encounters a severe error that has the potential to crash the operating system, it
immediately halts the offending program and displays an error message that says the application has
encountered a problem and needs to close. Then, the operating system prompts you to send an error report to
Microsoft. You can avoid having to click the Don’t Send button by disabling Error Reporting. Here’s how:

1. Press [Windows][Break] to display the System Properties dialog box.
2. Select the Advanced tab and click the Error Reporting button.

3. When you see the Error Reporting dialog box, select the Disable Error Reporting option. (If you don’t
want to see any type of error message, clear the But Notify Me When Critical Errors Occur check box.)

4. Click OK twice — once to close the Error Reporting dialog box and once to close the System Properties
dialog box.

Automatically run a batch file when you open a Windows XP command
prompt
Note: This tip is for both Windows XP Home and Professional.

Caution: Editing the registry is risky, so make sure you have a verified backup before making any changes.

You probably run the same few commands each time you start using the command prompt in Windows XP. For
example, perhaps you first switch to the root directory and then clear the screen. You may have put these
commands into a batch file and saved the file to the C:\Documents and Settings\{username} folder so that when
you open the command prompt, you can simply type the name of the batch file to issue the commands.

You can save yourself from typing any commands at all if you add the path and name of the batch file to a
special key in the registry.

Here’s how to add them:

1. Launch the Registry Editor (Regedit.exe).
2. Gotothe HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Command Processor key.
3. Double-click the AutoRun value to access the Edit String dialog box.

4. Inthe Value Data text box, type the path and name of the batch file. Be sure to enclose the text in
double quotes — for example, “C:\Documents and Settings\greg\go.bat”.

5. Click OK to close the Edit String dialog box and close the Registry Editor.

Now, your batch file will automatically run every time you open the command prompt window.
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Configure Windows XP’s MS-DOS Editor
Note: This tip applies to both Windows XP Home and Windows XP Professional.

Windows XP comes with another text editor besides Notepad — it’s called the MS-DOS Editor, and it’s
commonly referred to simply as Edit. It has features similar to Notepad, as well as additional features, such as
the ability to work with multiple text files and change the background and text colors. Since Edit is a DOS-based
application, you can easily configure it to work just like a Windows application. Here’s how:

1. Use Windows Explorer to locate the Edit.com file in the \Windows\System32 folder.

2. Right-click the file, drag it to your desktop, and select the Create Shortcut(s) Here command from the
shortcut menu.

3. Right-click the Shortcut icon and select the Properties command from the shortcut menu.
4. Choose the Program tab and select the Close On Exit check box.
5. Click OK to finish.

Now you can double-click the Shortcut icon to launch Edit. When you're finished using it, you can close it by
clicking the Close button in the upper-right corner or by using the Exit command on the File menu.

Download free hard disk imaging utilities for Windows XP
Note: This tip applies to both Windows XP Home and Professional.

Windows Vista’s hard disk imaging utility, Complete PC Backup, allows users you to create an image file that
contains the complete contents and structure of a hard disk. If you want this capability in Windows XP, you don’t
have to pay for a third-party utility, such as Acronis True Image.

If you have a Seagate or Maxtor hard drive, you can get a free copy of the original equipment manufacturer
(OEM) version of Acronis True Image. Seagate provides this tool for migrating your files from an older Seagate or
Maxtor hard disk to a new one. You can also use the tool as a backup utility by downloading either the Seagate
DiscWizard or Maxtor MaxBlast software.

After you download and install either of these OEM version packages, you’ll be able to quickly and easily create
a complete image backup of your Windows XP hard disk just like you can in Windows Vista.

Reposition Windows XP’s Quick Launch toolbar
Note: This tip applies to both Windows XP Home and Windows XP Professional.

If you think that Windows XP’s Quick Launch toolbar takes up a lot of room on the taskbar at the top of your
screen, here’s how you can easily move the toolbar to any other location on the desktop:

1. Position your mouse pointer over the vertical bar on the left edge of the Quick Launch toolbar until your
cursor turns into a double-headed arrow.

2. Drag the Quick Launch toolbar to any location on the desktop — you can anchor it to the top, left, or
right edge of the desktop.

3. Once you position it where you want, you can right-click on the toolbar and select the Always On Top
command so that you can always access the Quick Launch toolbar just like you can the taskbar.
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Find and download new fonts for Windows XP
Note: This tip applies to both Windows XP Home and Windows XP Professional.

Windows XP provides a host of fonts you can use to enhance your documents both onscreen and in printed
form. When you install certain applications, you’ll find that even more fonts have been added to your operating
system. Even so, you may still have a longing for more fonts.

Check out Dafont, which offers a huge repository of fonts available as freeware, shareware, demo versions, or
public domain, that you can download and install at will. If you know what you want, you’ll appreciate the fact
that the fonts are sorted alphabetically, by author, and by themes. If you’re just browsing, check out the new
fonts and top 100 sections. What makes this site even more intriguing is that you can type in your own text and
see what it looks like in any of the available fonts.

Reset Internet Explorer’s window size in Windows XP

Note: This tip applies to both Windows XP Home and Windows XP Professional. As this is a function of Windows
XP, it will work on all versions of IE.

If you typically maximize a too-small Internet Explorer window in XP, every subsequent time you launch Internet
Explorer, its windows may remain too small. By default, Internet Explorer is supposed to open at the same size it
was the last time it was closed. However, sometimes, the default setting gets out of whack, and you need to
manually reset it. Here’s how:

1. Launch Internet Explorer.

2. Click one of the window corners and drag it out to completely fill your screen. Do not use the Maximize
button.

3. Press [Alt] to view the menu bar (if you are using Internet Explorer 7).
4. Press and hold down either [Ctrl] or [Shift] while selecting Exit from the File menu. Do not use the Close

button.

Now when you launch Internet Explorer, it should open in a full window. If it opens in the same small window,
repeat the steps but hold down the opposite key in step 4; that is, either [Ctrl] or [Shift].

Create a custom Control Panel in Windows XP
Note: This tip applies to both Windows XP Home and Windows XP Professional.

To simplify access to the tools in Windows XP’s Control Panel, Microsoft created the Category View, in which the
Control Panel’s tools are organized into categories. If you’re an old-school Windows user, you can still switch
back to the Classic View, in which all of the Control Panel’s tools are available. If you admire the simplicity of the
Category View but prefer the Classic View, you may want to create your own custom Control Panel that
combines the best of both views. Here’s how:

1. Right-click the Start button and select the Explore command.
2. GotoFile | New | Folder.

3. Name the new folder My Control Panel.
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4. Right-click your new My Control Panel folder, select the Properties command, choose the Customize tab,
click the Change Icon button, and select an icon that will differentiate this folder from all the rest on the
Start menu.

5. Open your new My Control Panel folder and then open the original Control Panel and select Classic
View.

6. Drag and drop your favorite tools from the original Control Panel to your new My Control Panel folder.
7. Close both your new My Control Panel folder and the original Control Panel.

Now when you need to use your favorite tool, just click Start | All Programs and at the top of the All Programs
menu, select the My Control Panel folder. You’ll see your favorite tools in an easy to access drop-down menu.

Viewing non-present devices in Windows XP's Device Manager
Note: This tip applies to both Windows XP Home and Windows XP Professional.

When troubleshooting driver problems in Windows XP, one of the first places you may look is Device Manager,
which provides detailed information about every piece of installed system hardware. But with devices such as
removable USB drives becoming more and more common, you may need information about devices that are not
currently connected. Device Manager recognizes these as non-present devices. Here's how to get information
about them:

1. Go to Start, right-click My Computer, and select Properties.

2. Inthe System Properties dialog box, select the Advanced tab and click the Environment Variables
button.

3. Inthe Environment Variables dialog box, locate the System Variables panel and click New.

4. Inthe New System Variable dialog box, type DEVMGR_SHOW_NONPRESENT_DEVICES in the Variable
Name text box and type 1 in the Variable Value text box.

5. Click OK twice.
6. To view the non-present devices, go to Start, right-click My Computer, and select Manage.

7. Click Device Manager, pull down the View menu, and select Show Hidden Devices.

Forcing Windows XP's Disk Cleanup to delete all temporary files
Note: This tip applies to both Windows XP Home and Windows XP Professional.

Caution: Editing the registry is risky, so make sure you have a verified backup before making any changes.

If you've ever run the Windows XP's Disk Cleanup utility, you probably discovered that your temporary files
occupy a significant amount of space. You might select the Temporary Files check box to allow the Disk Cleanup
utility to delete the files in the Temp folder, but the Disk Cleanup utility will not remove all of the files. The
reason for this oddity is that the configuration for the Disk Cleanup utility does not allow deletion of files
accessed in the last seven days.
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By altering the LastAccess value in the registry, you can configure the Disk Cleanup utility to delete all the files in
the Temp folder regardless of the last accessed date. Here's how:

1. Launch the Registry Editor (Regedit.exe).

2. Goto:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
Explorer\VolumeCaches\Temporary Files

3. Locate and double-click the LastAccess value.

4. When you see the Edit DWORD Value dialog box, change the Value Data setting from 7 to 0 and
click OK.

5. To complete the operation, close the Registry Editor and restart Windows XP.

Changing the value to 0 will force the Disk Cleanup utility to delete all the files in the Temp folder every time you
select the Temporary Files check box.

Speed up Windows XP's Search Companion
Note: This tip applies to both Windows XP Home and Windows XP Professional.

Caution: Editing the registry is risky, so make sure you have a verified backup before making any changes.

One reason Windows Vista's Search tool is so fast is that rather than searching your whole hard disk, it searches
only the Documents folders. So the next time you pull up Windows XP's Search Companion, click All Files And
Folders and select My Documents from the Look In drop-down list. This prevents the Search Companion from
searching the entire hard disk.

If you want to search documents stored in the root folder, you can still speed up the process by removing
system folders from the search. Click All Files And Folders, open the More Advanced Options panel, and clear
the Search System Folders check box. If the Search Hidden Files And Folders check box is selected, clear it too.

If your hard disk contains a lot of ZIP files (or compressed folders, as Windows XP calls them), the Search
Companion will search through each of those as well, albeit more slowly. To prevent the Search Companion
from searching through compressed folders, either move all of them to the root folder and then configure the
Search Companion to search only the My Documents folder or disable Windows XP's support for compressed
folders.

To disable this support, access the Run dialog box, type the command regsvr32 /u zipfldr.dll in the Open text box
and click OK. You'll then need to restart the system for the change to take effect. (To re-enable Windows XP's
support for compressed folders, use the command regsvr32 zipfldr.dll.)

What if the Search Companion is disabled?
If you've disabled Windows XP's Search Companion interface and are using the Windows 2000 Search interface
instead, you'll need to make the following adjustments to this tip:

# To search My Documents, select My Documents from the Look In drop-down list.

# To remove system folders from the search, click Search Options, select the Advanced Options check box,
and then clear the Search System Folders check box. (If the Search Hidden Files And Folders check box is
selected, clear it too.)

To prevent the searching of compressed folders, you can use the same technique as you would for the
Search Companion.
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Additional resources
TechRepublic's Downloads RSS Feed EL0H
Sign up for TechRepublic's Downloads Weekly Update newsletter

Sign up for our Windows XP newsletter

Check out all of TechRepublic's free newsletters

10 Windows XP tips and tools to simplify your work (TechRepublic download)
The Windows XP IP Configuration Tool (TechRepublic download)

* & * & * & »

10 handy Windows XP efficiency tricks (TechRepublic download)

Version history

Version: 1.0
Published: September 10, 2007

Tell us what you think

TechRepublic downloads are designed to help you get your job done as painlessly and effectively as possible.
Because we're continually looking for ways to improve the usefulness of these tools, we need your feedback.
Please take a minute to drop us a line and tell us how well this download worked for you and offer your
suggestions for improvement.

Thanks!

—The TechRepublic Downloads Team
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